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Trade Analyzer Overview
Trade Analyzer gives a risk manager or trader the ability to analyze the current day’s trades from a comprehensive statistics report.  With individual trades analysis, time analysis, performance graphs, and trade lists, Trade Analyzer is the perfect tool for training new traders or reviewing current trader performance.  Trade Analyzer provides detailed trader performance reports that:
· Allow traders to quickly distinguish winning trade characteristics vs. losing trade characteristics 
· Allow detailed statistical reports on all trades, long trades, and short trades
· Allow traders to evaluate their vital performance statistics 
· Allow risk managers to pinpoint trader’s weaknesses and strengths 
· Allow traders and risk managers to find most profitable times of the day for their trading 
· Allow traders and risk managers to graphically view trade statistics 
Installation

1. Verify that both X_TRADER and the X_TRADER API are installed.  Verify that X_TRADER Pro is enabled.
2. Install the Microsoft .NET Framework.

3. Double-click on the installation file (i.e. Trade_Analyzer_Install.exe).  This opens the Trade Analyzer installation wizard.

4. Click the Next button through all of the screens of the installation wizard, changing the default User Information and Destination Folder if desired. 

5. The application will be installed.  The last screen will display a message stating that Trade Analyzer was successfully installed. 

6. Click the Finish button.  A Trade Analyzer shortcut icon will be added to the Desktop.  The computer does not need to be rebooted.

7. The user can launch Trade Analyzer by double-clicking the Trade Analyzer desktop icon after they start X_TRADER® Pro.  It will automatically load the trade information. 

Product Features
Menu Options

Within the File menu there are five menu items: 

	· Export…
	Opens a window to export the currently selected contract’s trade analysis information.

	· Export All…
	Opens a window to export trade analysis information for all contracts in Trade Analyzer.

	· Print…
	Opens a preview window to print the currently selected contract’s trade analysis information.

	· Print All…
	Opens a preview window to print trade analysis information for all contracts in Trade Analyzer.

	· Exit
	Exits the Trade Analyzer application.


Within the Settings menu there are four menu items: 

	· Commissions…
	Opens a configuration window for the Commission Settings.

	· Exchange Time Offset…
	Opens a configuration window for the Exchange Time Offset.

	· Currency Code
	Provides a drop down where users can select which Currency they would like to use. 

	· Possible P&L Track Time (min)
	Provides a text box where users can enter the amount of time in minutes they wish to track price movement after a trade is completed. This is used to calculate Possible Profit and Possible Loss. 


Within the Help menu there are two menu items: 

	· Contents
	Opens the Trade Analyzer Read-me document.

	· About Trade Analyzer
	Opens a splash window that displays specifics about the Trade Analyzer application. 


Export and Print

Trade Analyzer allows exporting of the Trade Analysis, Time Analysis, and Trades Lists data. You can export by individual account or all accounts in HTML (.htm) or Excel (.xls) format.

Export

To export an individual account’s statistics, select the account and product from the menu tree and choose Export from the File menu.

Export All
To export all account’s statistics, select Export All from the File menu, and Trade Analyzer will export all account’s and product’s statistics.

Print

To print an individual account’s statistics, select the account and product from the menu tree and choose Print from the File menu.

Print All
To print all account’s statistics, select Print All from the File menu, and Trade Analyzer will print all account’s and product’s statistics.

Export Formats
HTML

Trade Analyzer can export reports in HTML format for web browser viewing.

EXCEL 

Exporting reports in Excel format allows the user to export the Trades List data as well as the Trade and Time Analysis data.

Settings
The Settings menu allows the trader to set various default settings:

· Define the commissions for each product 

· Define the time offset for each gateway

· Define the default currency 

· Define the track time for the possible profit/loss statistics
Commission Settings

Enter contracts into this window, shown in Figure 1, if you would like Trade Analyzer to account for trading fees when calculating P&L.  For each contract you can specify a Commission value.  The commission will not be converted to the primary currency of each exchange; it will simply be used as an absolute value for each fill.
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              Figure 1. Commission Settings



Time Offset Settings

Change the value of the exchange time offset in the “Time Offset Settings” window, shown in Figure 2, to tell Trade Analyzer how many hours to stagger your trade information from the exchange-provided time.  If your time zone is five hours behind the CME's, for example, your exchange time offset should be set to -5. Please note that in this context Exchange refers to the gateway.
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Figure 2. Time Offset Settings




Trade Definitions

1. A trade is created when the trader takes a position in the market after being flat or when the trader goes from Short to Long or from Long to Short.  A Trade contains all the fills received while the trader has an open position and until that position is closed.  A trade is defined as going from being flat to having a position, then being flat again.
2. A “long trade” is a trade where the trader enters a position from the long side (buys to establish a position). 
3. A “short trade” is a trade where the trader enters a position from the short side (sells).
4. Example:  If the trader bought ten, sold five, bought five, then sold ten, that would count as only one trade. 
5. In addition to analyzing the total trading activity, Trade Analyzer separates trades into long trades and short trades and then analyzes them separately as well.  Trade analyzer presents information in three columns: Total, Long, and Short.
Navigation

Trade Analyzer provides a collapsible list of all contracts it has tracked data for.  Refer to the left hand side of Figure 3.  The contract nodes are selectable.  When a user clicks on a specific contract, Trade Analyzer will then display data for that contract.  Every level can be expanded or collapsed to conserve space.
Trade Analysis Tab 

Click on the “Trade Analysis” tab, shown in Figure 3, to view Analytical data specific to the current contract.  
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Figure 3. Trade Analysis Tab
	Trade Analysis – Data Columns

	Column Name
	Description

	Total
	The numbers under Total detail the total trading activity for the selected contract.  This is a cumulative column that contains data for all trades for that contract.  The “Round Trips” and “Net P&L” values in this column should match the values in X_TRADER’s Fill Window, assuming the currencies are the same.

	Long
	Displays all trading information regarding long trades.

	Short
	Displays all trading information regarding short trades.


	Trade Analysis – Data Fields

	Field Name
	Field Type
	Description

	Total Number of Trades
	Integer
	This displays the total number of trades.

	Winning Trades
	Integer
	This is the total number of profitable trades made.

	Losing Trades
	Integer
	This is the total number of losing trades made.

	Breakeven Trades
	Integer
	This is the total number of trades you scratched today. A scratch is a trade on which money was neither made nor lost.

	Total Round Trips
	Integer
	This is the total number of buys and sells for the entire analysis interval and reflects only completed trades.  A trade is considered completed when the position is zero.

	P&L (Ticks)
	Ticks
	This is the total number of ticks made or lost.

	Avg Tick Size Winners
	Ticks
	This is the average number of ticks made on winning trades.  This is an absolute number, not conditioned on the number of contracts bought or sold per trade.  That is, if the trader buys, then sells one tick higher, that is a one-tick winner.  It doesn’t matter whether the trader bought one contract or one hundred.

	Avg Tick Size Losers
	Ticks
	This is the average number of ticks lost on losing trades.  Like the “Avg Tick Size Winners” number, it is absolute, not conditioned on the number of contracts bought or sold.

	Gross Profit
	Currency
	This is the total amount of money that was made on winning trades, in the selected currency, before trading fees are taken into account.

	Gross Loss
	Currency
	This is the total amount of money that was lost on losing trades, in the selected currency, before trading fees are taking into account.

	P&L
	Currency
	This is the total amount of money made or lost, before transaction fees have been deducted.

	Commission
	Currency
	This is the commission for today’s transactions.  This number is calculated based on the commissions that are entered in the Commission Settings window, accessed from the Settings menu.

	Net P&L
	Currency
	This is the total amount of money made or lost today after transaction fees have been deducted.

	Profit Factor
	Decimal
	Profit Factor = |(Gross Profit / Gross Loss)|
This statistic describes how much the trader made for every dollar that was lost.  Similar to the Impact Ratio, this measures profitability on a Gross Profit/Gross Loss basis.

	Impact Ratio
	Decimal
	Impact Ratio = |(Avg Profit for Winners/Avg Loss for Losers)|
This statistic measures the average profit on each winning trade versus the average loss on each losing trade.  A reading above 1.0 indicates that the trader’s returns on winning trades is larger than the losses on losing traders.
(Refer to Trading Risk by Kenneth L. Grant)

	Performance Ratio
	Decimal
	Performance Ratio = 
         (Winning Trades / Total Number of Trades) * Impact Ratio

This statistic combines the percentage accuracy of a trader with the impact ratio to provide an index that describes the trader’s efficiency.

(Refer to Trading Risk by Kenneth L. Grant)

	Standard Deviation
	Decimal
	Standard Deviation = 

           √((∑(Trade P&L – Total Avg P&L)2)/Total # Trades)
This statistic describes the volatility of a trader’s return.

	Avg P&L All
	Currency
	This is the average amount of money made or lost per trade.

	Avg Heat/Profit
	Currency
	The red number on the left is the average amount the trader could have lost per trade.  The blue number on the right is the average amount the trader could have made per trade.

	Max Heat/Profit
	Currency
	The red number on the left is the largest amount the trader could have lost on a single trade.  The blue number on the right is the largest profit the trader could have made on a single trade.

	Avg Profit for Winners
	Currency
	This is the average amount of money made per winning trade.

	Avg Loss for Losers
	Currency
	This is the average amount of money lost per losing trade.

	Largest Gain
	Currency
	This is the amount of money made on the most profitable trade.

	Largest Loss
	Currency
	This is the amount of money lost on your biggest losing trade.

	Percent Accuracy
	Percent
	This is how many trades today were profitable, as a percentage of the total number of trades made.  For this number, scratches (breakeven trades) and losing trades count against the trader equally.

	Percentage Breakeven Trades
	Percent
	This is how many trades were scratches, as a percentage of the total number of trades.


Time Analysis Tab 

Clicking on the tab that says “Time Analysis”, shown in Figure 4, will bring a different set of information to the fore.
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Figure 4.Time Analysis Tab
	Time Analysis – Data Columns

	Column Name
	Description

	Total
	Displays time information for all trades for the selected contract.

	Long
	Displays time information regarding long trades.

	Short
	Displays time information regarding short trades.


  
	Time Analysis – Data Fields

	Field Name
	Field Type
	Description

	Average Duration of Trades
	Time
	The average amount of time that the trader is holding onto trades.

	Average Duration of Winning Trades
	Time
	The average amount of time that the trader is holding onto winning trades.

	Average Duration of Losing Trades
	Time
	The average amount of time that the trader is holding onto losing trades.

	Average Duration of Breakeven Trades
	Time
	The average amount of time that the trader is holding onto breakeven trades.

	Average Time Between Trades
	Time
	The number in the first box is the average amount of time the trader spent waiting, inactively, between trades.  The numbers under “Winning” and “Losing” are meant to be the same thing, broken down by periods during which the trader had a positive cumulative P&L (Winning) or a negative cumulative P&L (Losing) for the selected contract.

	Percentage First Hour Trades
	Percent
	The percentage of trading activity that took place within one hour of the first trade.

	Percentage Last Hour Trades
	Percent
	The percentage of trading activity that took place within one hour of the last trade.


Trade Graphs Tab
This tab allows the user to view several graphs detailing the trading activity.  There are six available trade graphs. In order to change the graph being displayed, click the drop-down menu and select the name of the graph to view.  The available graphs are:
· P&L Per Trade 
· Profit Per Trade
· Loss Per Trade
· Cumulative P&L When Flat
· P&L Per Hour
· Ticks Distribution
P&L Per Trade
This graph, shown in Figure 5, displays all of the trades in the order that they occurred.  Blue bars represent winning trades, and red bars represent losing trades.  Breakeven trades will not have a bar.
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Figure 5. P&L Per Trade Graph
Profit Per Trade 
This graph, shown in Figure 6, isolates winning trades and displays them in chronological order.
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Figure 6. Profit Per Trade Graph
Loss Per Trade
This graph, shown in Figure 7, isolates losing trades and displays them in chronological order.
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Figure 7. Loss Per Trade Graph
Cumulative P&L When Flat 
This graph, shown in Figure 8, displays the trader’s Net P&L over the course of the day.  It starts at zero, and after every trade, it adds any winnings or subtracts any losses.
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Figure 8. Cumulative P&L When Flat Graph
P&L Per Hour
This graph, shown in Figure 9, displays a bar for each hour that the trader traded.  Hours during which the trader made money will be blue, and hours during which money was lost will be red.
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Figure 9. P&L Per Hour Graph
Ticks Distribution
This graph, shown in Figure 10, displays the number of times the trader made or lost various numbers of ticks on a trade.
· The X-axis (“Number of Ticks”) represents the number of ticks made or lost on a trade. In the example below, the trader’s biggest single loss was a sixteen-tick loser, and the biggest winner was a nine-tick winner. The number zero represents a scratch.
· The Y-axis (“Number of Trades”) represents the number of times the trader made or lost each particular number of ticks. In the example below, the trader lost four ticks three separate times.
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Figure 10. Ticks Distribution Graph
Performance Graphs Tab
This tab allows the user to view several graphs detailing the trader performance.  There are four available performance graphs. In order to change the graph being displayed, click the drop-down menu and select the name of the graph to view.  The available graphs are:

· Favorable Excursion
· Adverse Excursion
· Actual P&L with Max Heat/Profit
· Actual P&L with Poss. Loss/Profit
Favorable Excursion

This graph, shown in Figure 11, is designed to show how effectively a trader is choosing exit points by comparing P&L to Max Profit.  Theoretically the goal of every trade is to receive a P&L as close to the Max Profit as possible. The blue triangles represent winning trades and the red triangles represent losing trades. The gray line sloping up and to the right represents the best case scenario for every trade. If a blue triangle shows up on the gray line, the trader made as much money as they possibly could have throughout the duration of their trade. The graph of a very successful trader would have many blue triangles very close to the gray line. The graph of a very unsuccessful trader would have many red triangles far away from the gray line.
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Figure 11. Favorable Excursion Graph
Adverse Excursion

This graph, shown in Figure 12, is designed to show how effectively a trader is choosing exit points by comparing P&L to Max Heat.  Theoretically the goal of every trade is to receive a high P&L with low heat. The blue triangles represent winning trades and the red triangles represent losing trades. The gray line sloping down and to the right represents the worst case scenario for every trade. If a red triangle shows up on the gray line, the trader lost as much money as they possibly could have throughout the duration of their trade. The graph of a very successful trader would have many blue triangles far to the left of the graph. The graph of a very unsuccessful trader would have many red triangles appearing close to the gray line. 
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Figure 12. Adverse Excursion Graph
Actual P&L with Max Heat/Profit
This graph, shown in Figure 13, is designed to show the difference between the amount of money you made or lost on each trade and the amount you could have made or lost over the same period of time had you placed your orders differently. The solid bar in front displays the trader's actual profit or loss on the trade, and the lighter outlined bars behind that display the maximum amount the trader could have made or lost.
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Figure 13. Actual P&L with Max Heat/Profit Graph
Actual P&L with Poss. Loss/Profit
This graph, shown in Figure 14, is designed to show the difference between the amounts of money you made or lost on each trade and the amount you could have lost, if you held on longer. The solid bar in front displays the trader's actual profit or loss on the trade, and the lighter outlined bars behind that displays the maximum amount the trader could have lost or gained over a predetermined time period.

The user specifies the amount of time Trade Analyzer tracks the market after a trade is completed, in order to calculate the Poss. Loss/Profit.  To change this setting, change the “Possible P&L Track Time” value in the Settings dropdown.
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Figure 14. Actual P&L with Poss. Loss/Profit Graph
Trades Tab
The Trades tab, shown in Figure 15, displays a text-based representation of everything the trader did and when it happened.  There are four columns that can be used to study your potential profits and losses. The Max Heat and Max Profit columns display, for each trade, the maximum profits and losses that could have been taken, while the Poss. Loss and Poss. Profit columns display the profits or losses that could have been available, had the trader held on to the open position for a user-specified time period instead of closing out the trade.  This amount of time, in minutes, is set in the Possible P&L Track Time item within the Settings menu.
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Figure 15. Trades Tab
	Trades – Data Fields

	Field Name
	Field Type
	Description

	Start Time
	Time
	This is the time when the first fill of each trade occurred.

	End Time
	Time
	This is the time when each fill happened, and the time of the last fill of the trade in the summary lines.

	Buys
	Integer
	This is the fill qty for each fill if the order was a buy. On the trade summary line, this is the total buy quantity for all fills in that trade.

	Sells
	Integer
	This is the fill qty for each fill if the order was a sell. On the trade summary line, this is the total sell quantity for all fills in that trade.

	Fill Price
	Currency
	This is the price at which each fill occurred.

	Position
	Integer
	This is the overall position quantity. Each fill will record the total position after that fill occurred in this field.

	P&L (Ticks)
	Ticks
	On the trade summary line, this is the overall P&L displayed as a tick value. For each fill, this is the P&L in ticks made on that fill. Trade Analyzer uses a FIFO matching policy when determining P&L for an individual fill.

	P&L
	Currency
	On the trade summary line, this is the overall P&L before commissions for that trade. For each fill, this is the P&L made on that fill. Trade Analyzer uses a FIFO matching policy when determining P&L for an individual fill.

	Commission
	Currency
	On the trade summary line, this is the overall commission charge for that trade. For each fill, this is the commission charged for that individual fill.

	Net P&L
	Currency
	On the trade summary line, this is the overall P&L after commissions for that trade. For each fill, this is the P&L made on that fill. Trade Analyzer uses a FIFO matching policy when determining P&L for an individual fill.

	Max Heat
	Currency
	The Max Heat is a measurement of how much a trader could have potentially lost during the course of a trade.

Max Heat = Total Aggregated Sell Price – Total Aggregated Buy Price - (Open Position Qty * LTP)

*Total Aggregated Price = ∑(Fill Price * Quantity)
The Max Heat is the lowest value returned by this formula throughout the duration of the trade. This value will be either zero or negative. As the trader starts to flatten a position they start to lock in profit/loss and the formula for Max Heat is less affected by the Last Traded Price (LTP).

	Max Profit
	Currency
	The Max Profit is a measurement of how much a trader could have potentially made during the course of a trade.

Max Profit = Total Aggregated Sell Price – Total Aggregated Buy Price + (Open Position Qty * LTP)
*Total Aggregated Price = ∑(Fill Price * Quantity)
The Max Profit is the largest value returned by this formula throughout the duration of the trade. This value will be either zero or positive. As the trader starts to flatten a position they start to lock in profit/loss and the formula for Max Profit is less affected by the Last Traded Price (LTP).

	Possible Loss
	Currency
	The Possible Loss is the maximum amount of money the trader could have lost had they not closed out the trade. The amount of time after the trade is completed that Trade Analyzer tracks the Possible Loss is based on the Possible P&L Track Time, configurable from within the settings menu.
Possible Loss for Buys = Fill Price - LTP
Possible Loss of Sells = LTP – Fill Price  


(For flattening fills only)

Possible Loss only tracks Last Traded Price (LTP) after the trade is closed out. The value displayed as Possible Loss will be the lowest number returned by this formula during the specified time after the trade is closed, and will be either zero or negative.
The Trade summary line will show an aggregated value from the rows below + the P&L to show a possible P&L value.

	Possible Profit
	Currency
	The Possible Profit is the maximum amount of money the trader could have made had they not closed out the trade. The amount of time after the trade is completed that Trade Analyzer tracks the Possible Profit is based on the Possible P&L Track Time, configurable from within the settings menu.

Possible Profit for Buys = Fill Price – LTP
Possible Profit for Sells = LTP – Fill Price  


(For flattening fills only)

Possible Profit only tracks Last Traded Price (LTP) after the trade is closed out. The value displayed as Possible Profit will be the largest number returned by this formula during the specified time after the trade is closed, and will be either zero or positive.
The Trade summary line will show an aggregated value from the rows below + the P&L to show a possible P&L value.


Requirements
This application requires:
· X_TRADER® API 

· X_TRADER® Pro 

· MICROSOFT EXCEL 2003 for Export feature

· .Net Framework 1.1
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